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1 
Introduction 

The Formulary Benefits add-on function is available as an extra cost option for use 
with e-MDs Solution Series. With these functions, Solution Series users can:  

• Determine the pharmacy benefits and drug copays for a patient’s health plan. 

• Check whether a prescribed medication is covered (in formulary) under a patient’s 
plan. 

• Display therapeutic alternatives with preference rank (if available) within a drug 
class for non-formulary medications. 

• Determine if a patient’s health plan allows electronic prescribing to Mail Order 
pharmacies, and if so, e-prescribe to these pharmacies.  

• Download a historic list of all medications prescribed for a patient by any provider 
(if that medication was submitted for payment as part of any health insurance 
plan.) 

The Formulary Benefits function allows users to determine the formulary coverage 
(i.e.: whether the patient’s insurance plan provides reimbursement for a specific 
dispensable medication) prior to prescribing. Other pharmacy-related information, 
such as medication copay amounts, the need for prior authorization, quantity limits, 
and coverage restrictions by age or gender may also be available.  

Further, when a prescribed medication is flagged as not in formulary, the function can 
display a list of therapeutic alternative choices that are covered. This allows clinicians 
the option to prescribe “in plan” medications (if appropriate) for their patients. 

This guide provides instructions for using this function with the Solution Series 
modules. 

Continued on the next page ... 

e-MDs Solution Series Formulary Benefits User Guide 8.0 R00 1 



 

Using This Guide 
As you go through this guide, you will notice that each set of steps to perform a task begins with an 
indented heading starting with "To" and ending with a colon (:).  That heading is then followed by indented 
steps to be performed in a prescribed sequence.  For example, after a brief overview of when you may 
want to select an electronically enabled mail order pharmacy, the procedure looks like the contents of the 
following box: 

To select an electronically enabled mail order pharmacy: 
1. Click the Search icon located in the Pharmacy column to display the Find Pharmacy window. 

2. Click only the check box Electronically Enabled Mail Order, then click the Search icon.  

3. Highlight the desired pharmacy and click the Select icon. 

Note:  In this example, we streamlined the steps by removing sample screens.  For more details on this 
procedure, see that section of this guide. 

Related Documentation 
Documentation for Solution Series modules is provided in PDF (Portable Document Format) files for 
viewing and printing individually, and in Help format for easy access from each product module.  Both 
formats and access methods provide the same information.  The documentation library is updated 
extensively for each major product release as well as updated and corrected periodically, as needed.  For 
the latest version of any Solution Series documentation, go to the documentation section of the e-MDs 
Support site at Online Support > Downloads > Documentation. 

The following documents are available to all Solution Series users: 

• e-MDs Solution Series Administration Guide is your starting point for initializing and customizing 
Solution Series modules for use in your organization.  This guide provides step-by-step 
instructions for licensing your software, adding system users and defining access levels, adding 
and modifying user groups, and setting up default handling of various module tasks. 

• e-MDs Solution Series Bill User Guide provides instructions for working with insurance codes and 
electronic claims, setting fee schedules and rules, defining policies, posting and billing 
transactions and reversals, and performing numerous other practice management tasks. 

• e-MDs Solution Series Chart User Guide leads you from the beginning of an office visit through 
the visit conclusion when billing is enabled.  Using Chart you can track and code a patients 
medical information and provide prenatal, maternity and postnatal care.  This guide also details 
Chart's prescription processing, lab interfaces, and telephone interactions with patients. 

• e-MDs Solution Series Installation and Upgrade Guide leads you through the preparation of your 
site for Solution Series, the database and application installation steps, and post-installation 
configuration.  If Solution Series is already installed at your facility, use the update instructions 
provided in this guide to update your system. 

• e-MDs Solution Series Schedule User Guide leads you through scheduling and tracking 
appointments, setting up and modifying patient accounts, blocking time on the calendar to restrict 
appointment scheduling, checking patients into the facility and tracking their progress through 
each encounter with a provider, and checking eligibility. 

• e-MDs Solution Series Reports User Guide lists the reports available through Solution Series.  A 
description of each report is provided, along with the location of the report within Solution Series 
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modules, the available fields and filters used to select specific data for the report, and samples of 
most reports, illustrating what you can expect when running a report at your facility. 

• e-MDs Solution Series Utilities Guide covers tools and utilities that may be used with various 
Solution Series modules.  This includes using: DocMan to graph lab results, process incoming 
faxes, and generate and send documents to patients and external resources such as specialist 
referrals and labs. 

○ TaskMan to automatically send messages, implement secure e-mail, and track tasks to be 
performed within Solution Series. 

○ Snapshot/Digicam to capture images of patients/staff and add them to patient and user 
records. 

○ Forms/Letter Builder to generate, print and send forms and letters from within Solution 
Series.  This includes the use of Microsoft Word and the e-MDs database to create 
customized/merged letters and documents. 

○ Registry Processor to create, view, distribute and print customized reports based on patient 
demographics and healthcare records. 

Additional documentation is also available on the e-MDs Support site for performing specific tasks and for 
using e-MDs interface products for working with labs and other organizations.  See the e-MDs Support 
site for access to the latest versions of these documents. 

Getting Additional Help and Information 
e-MDs realizes that one of the most important elements of any software system is the support services 
backing it up. There are a number of support resources available to help you optimize the use of your 
system and participate in the e-MDs community.  

Help Screens 
Help is accessible on each Solution Series application and module by going to Help > Search Topic on 
each application's top toolbar.  Related help files, such as this guide, the Utilities Guide, and the Reports 
User Guide are generally accessible from the same help screen.  After opening each help file, you can 
use the table of contents, index or search function to locate the specific information you need.  

Online Help files are also available through the application toolbar for Portal applications by clicking the 
question mark. The following Help is available for the Portal application: 

• e-MDs Patient Portal: The Clinic’s Guide to Using the Portal provides instructions for maintaining 
user access on a Patient Portal, working with patient appointments scheduled through the Portal, 
communicating with patients through a Portal e-mail interface, processing prescription refill 
requests, and auditing Patient Portal usage. 

• e-MDs Patient Portal: The Patient’s Guide to Using the Portal instructs patients on the use of the 
Patient Portal to communicate with their healthcare provider, view their own healthcare 
information, and submit requests for appointments and prescription refills.  This HTML file is 
provided on your Patient Portal for easy online viewing or printing by patients. 

 

User Guides 
The e-MDs Solution Series user guides contain comprehensive information about all standard product 
functions. This includes dealing with many of the complex situations that can arise in a medical office. 
Use the table of contents, index or search option to locate items of particular interest.  These guides are 
very similar to the application help screens.  See "Related Documentation" for a brief description of the 
Solution Series user guides available. 
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Solution Series guides are always available in electronic format (Adobe .pdf files).  You can put copies on 
each computer in the network.  You can download the Adobe Acrobat Reader for free from 
www.adobe.com  Updated user guides are included on the CD-ROMs you will receive with each upgrade, 
as well as on the support pages at www.e-mds.com.   

To download files from the e-MDs Support site, you will need your clinic password.  Instructions on how to 
apply for a password are on the Web site.  Only one password is issued per customer account, so please 
ensure you communicate this to your staff. 

Using the e-MDs Support Center 
The e-MDs Support Center is an online customer meeting place for clients with an active account.  It is 
accessed from the Support pages at www.e-MDs.com or 
http://supportcenteronline.com/ics/support/default.asp?deptID=3222 .  If you don’t have an account, you 
can request one by using the Request New Account button on the login page.  We strongly encourage 
each staff member in a clinic to have their own logins instead of one generic one for all people.  The 
primary reason for this is that when we need to push information such as update notifications it is sent to 
everyone meaning there is a smaller chance that the information will not be disseminated such as if 
someone is sick or ignores the message. 

Support Center includes the following tools that can be of great assistance to helping your practice work 
more efficiently with the e-MDs Software: 

• Forums/Newsgroups: The online forums are an e-MDs User Community where you can post 
messages related to support, general discussions, suggestions, tips and more.  It is a great non-
urgent support tool and is also searchable.  You can subscribe to various forums that interest you 
and get an e-mail notification if someone posts to them.  You can also elect to get an e-mail if 
someone posts to a specific message.  This is really useful if you post a question and want to 
know when it is answered.  Support forums are monitored by the e-MDs support team and a 
number of our customers also chip in with their knowledge. 

• Downloads: Downloads include shared templates for Chart, Word Forms, reports, updates to 
content such as ICD and CPT codes, bug patches, etc. 

• Knowledge Base: The knowledge base includes an extensive list of articles that you can use for 
troubleshooting, setup and so on.  These are generally posted based on questions from 
customers. 

• Troubleshooter: This search utility makes it easy to quickly locate the information you’re looking 
for.  It cross-references multiple parts of the support center and returns hyperlinks to articles, 
downloads and the like. 

• Surveys: Occasionally e-MDs will gauge your opinions about something via surveys which can 
be distributed via Support Center. 

• “Push” e-mails: If we want to let you know about something, we can push information to you 
from Support Center.  
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2 
Formulary Benefits 

 

Formulary Benefits data are maintained for health insurance providers by 
organizations known as Pharmacy Benefits Managers (PBM).  PBMs are third-party 
administrators of prescription drug programs whose primary responsibilities are 
processing and paying prescription drug claims. They also develop and maintain 
formularies, which are lists of dispensable drugs covered by a particular drug benefit 
plan. 

Solution Series obtains its PBM Formulary Benefits data from RxHub. 
Continued on the next page ... 
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Downloading Formulary Benefit Data 
Benefit data must first be downloaded from RxHub before it can be used in Solution Series.  

There are two types of Formulary Benefit downloads. One download (called a “batch” download) runs at  
night and downloads pharmacy benefit information for all patients holding appointments for the next day 
in the Scheduling module. The other download is performed as needed to obtain benefit information for a 
particular patient who was not included in the previous night’s batch download. 

Setting Up a Batch Download (Schedule or Bill Applications) 
Batch-based checking is done using the Report Manager application which is accessed under the 
Reports menu in either the Schedule or Bill modules. If your clinic is not currently using Report 
Manager to automate the generation of reports tasked to specific users, you will need to set the Batch 
download as a Windows Scheduled Task.  The task type in Report Manager is “RxHub Eligibility 
Check.”  

Here is some further Information about this task: 

• This task does not have any parameters. 

• Ensure that it is set up to run daily using the EOD option. 

• A path is not needed since this job simply sends ANSI X.12 270 files over web services. 

• You must set up designated users under the Task Info tab.  The user(s) will be messaged in 
TaskMan if there is a problem with a patient’s eligibility check.  If there is, it is an ANSI X.12 
standard for the information source (RxHub in this case) to respond with one of 3 file types: a 
997, a TA1, or a 271 response that includes an AAA segment.  The actual message that the user 
will see is built by parsing out elements of the response. 

• When the task is run, it will generate check files for patients with appointments scheduled for the 
24 hour period from the task run time. 

Setting Up Report Manager Tasks 
Report Manager is a module that can be run automatically using the Windows Scheduled Tasks program. 
You can also open the module and run the jobs manually if you want. It’s a timesaver regardless, 
because you have to set parameters each time. You can also refer to this section for defining the default 
network folder path in which reports are saved if they have a specific path identified in the specific job 
setup. 

To send a task based on a Report Manager job, you need to fill out the Task Info tab.  

To set up a Report Manager task: 
1. Open Bill or Schedule. 

2. Go to Reports > Report Manager. 

3. Click New. 

4. In the Select Report Module window, Billing is selected.  

5. Click RxHub Eligibility Check and click Select.  

6. In the New Rule window, on the Job tab, Rule Active is selected.  

7. For Parameters:  This job does not have any parameters.  

8. Ensure that it is set up to run daily using the EOD option.  
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9. File Path (optional):  A path is not needed since this job simply sends ANSI X.12 270 files over 
web services.  

10. Click the Task Info tab.  

11. Check Generate Task.  

12. Enter a Task Name. This is what the task recipients will see as the task subject.  

13. Enter the Attachment Description.  

14. You must designate users by clicking the Add/Modify button. The user(s) will be messaged in 
TaskMan if there is a problem with a patient’s eligibility check. If there is, it is an ANSI X.12 
standard for the information source (RxHub in this case) to respond with one of 3 file types: a 
997, a TA1, or a 271 response that includes an AAA segment. The actual message that the user 
will see is built by parsing out elements of the response.   

Note:  When the task is run, it will generate check files for patients with appointments scheduled 
for the 24-hour period from the task run time.  

15. Click Save. 

To Run RxHub Eligibility Check Automatically 
Report Manager has a "silent mode" that allows the program to run automatically through the Microsoft 
Window's Scheduler. This silent mode allows the program to run on at a scheduled interval without user 
intervention. For Report Manager to run in silent mode, setup information must be input in both Report 
Manager and in the Windows Scheduler. This setup needs to be done on one computer on the network; 
setting the silent mode on more than one computer can cause the program to fail to run. 

To set up the Windows Scheduler: 
1. Open the scheduler by going to Start > Programs > Accessories > System Tools > Scheduled 

Tasks. 

2. In the Scheduled Tasks window, click the Add Scheduled Task button. This will open a 
Scheduled Task Wizard. 

3. Click Next in the first window.  

4. In the second window, browse to the folder where Report Manager is stored and select it (by 
default, the program is stored in Program Files\e-MDs\SolutionSeries\Apps\).  

5. Select the Report Manager file and click Next. 

6. In the next screen, type in a name for the task to be scheduled (the task name can be the same 

7. as the program name), and select how often the task should be run. It is highly suggested that 
these rules be run daily.  

8. Click Next. 

9. In the next screen, select the start time and the frequency with which the task should be run (for 
example: Everyday, Weekdays, or Every x days) and the date the task should start running. Keep 
in mind that in clinics with a large patient population, the rules may take as long as 2 to 3 hours to 
run. 

Because of the amount of "processing time" that the rules demand from the computer, it is best to 
schedule these tasks to be run at night or during other off hours. Since these times are also when 
most businesses run their database backups and because the backups also require a lot of 
processing time, it is necessary to separate the scheduled times of these tasks. For example if a 
typical database backup starts at 10pm and takes about 2 hours, it would be necessary to either 
start the rule task after midnight or sometime well before 10PM, depending on the amount of time 
the rules take to run. 
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10. Enter a username and password on the next screen when prompted. The task will run as if it 
were started by that user. This username and password is the same one that would be used to 
log into the Windows network, not one that is used to log into e-MDs Solution Series. 

11. Click Finish at the next screen. 

There is one more thing to be done before the setup is complete.  

12. In the Scheduled Task window there will now be an icon representing the task that was just 
created. Double-click this icon to open the Properties window of the scheduled task. 

13. In the Properties window there will be a field labeled Run: with the path to the Report Manager 
file and another field below it labeled Start in: that also shows the path but without the executable 
listed. The following is an example of what the two fields might look like (depending on your 
setup): 

Run: "C:\Program Files\e-MDs\Solution Series\Apps\emdsReportManager.exe" /s 

Start in: "C:\Program Files\e-MDs\Solution Series\Apps" 

Important!  For the Rule Manager to run in silent mode, a space, forward slash, and the letter 
"s" ( /s) must be added to the end of the Run: path. This needs to be added OUTSIDE of the 
quotation marks. The following is an example of what the complete path should look like 
(depending on your setup): 

Run: "C:\Program Files\e-MDs\Solution Series\Apps\emdsReportManager.exe" /s  

Once the /s is added, the properties window can be closed and the Scheduler will run the rules 
automatically according to the time and frequency that were set up. This properties window can also be 
used to change the time and frequency of the scheduled task at a later date if necessary. 

Download for Individual Patient (Schedule Application) 
Users can also download formulary eligibility information for individual patients (example: a walk-in 
patient) in the Schedule application when needed. 

To download an individual patient from the Schedule application: 
1. Right-click the patient’s name in the schedule. 

 
2. Select (click) Individual Eligibility Check... from the menu options displayed. 
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3. Click the RxHub Check icon on the toolbar to download the Pharmacy Benefits Data for that 
patient. 

 
If a patient has Formulary benefits, benefit information displays in the lower pane of the Eligibility 
Check window.  

Note:  The RxHub Check icon will now be inactive (“grayed” out) . When inactive, this 
indicates that current information (i.e.: less than 24 hours old) have already been downloaded for 
this patient.  

 

Download for Individual Patient (Chart Application) 
Individual Formulary benefits information can also be downloaded from the ScriptWriter application in 
Chart.  

To download an individual patient from the ScriptWriter application in Chart: 
1. Open the Medication List for the patient ( go to Visit/HS > Medications > Refill Prescriptions) 

and click the RxHub Check icon . 
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This downloads formulary benefit data for that patient and displays it in the Pharmacy Coverage 
Pane. 

 

Again note that the RxHub Check icon is no longer active (“grayed” out) once the information 
has been downloaded indicating that the system now has current data for this patient. 

Important!  Solutions Series uses only “current” download data (i.e.: less than 24 hours old) for 
Formulary Benefits. Older download data (i.e.: greater than 24 hours old) are discarded by the system 
and users must run another download to access current data.  

The Coverage/Copay Pane 
Once a patient’s current formulary information has been downloaded, users can access available 
Coverage and Copay information for each drug on the Medication List. This information displays in the 
same pane (location) as the Prescriptions Notes (upper right corner of the Medication List).  

To check coverage and copay for a specific drug: 
1. Select (click) the medication from the Medication List, then click the Coverage/Copay tab.  

.         

Alternate Method: Click the coverage/copay icon  on the same line as the medication in the 
grid). 
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After flashing briefly with a red background, the information displays over a yellow background in 
place of the Prescription Notes. After a short interval, the system automatically redisplays the 
Prescription notes.  

2. Click the Coverage/Copay tab or grid icon again to redisplay that the benefit information.. 

Note that the Coverage/Copay pane provides two views of this data – Outline and Detail. The 
Outline View tab shows a summary of coverage information. 

 
3. Click the Detail View tab for view more specific information concerning the patient’s coverage.  

 

Important!  Not all PBMs collect and maintain the same information. As a result, some patient 
formulary benefit downloads may not the same information provided in a different patient’s download. 

Selecting In-Formulary Medications 
Several columns in the grid section of the Medication List window relate to coverage information 
concerning a specific medication. 
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These are: 

• Fm: The Formulary Status column. Icons appearing in this column indicate whether the drug 
listed on that line is in formulary. The icons and their meanings are as follows: 

  Approved Medication is included in Formulary (covered) for this patient. 
 
  Preferred Medication is included in Formulary and a preferred medication. 
 
  Non-Formulary Medication Drug is non-formulary and is normally not covered by the plan. 

 
  Non Reimbursable Medication is non formulary and is never covered by the plan. 
  
  Formulary Value Unknown Formulary status is unknown/has not been retrieved. 
 

• Rk: The Formulary Preference Level column. For medications substituted for non-formulary 
medication, a number (if relevant) indicates the preference level of the selected medication 
according to the formulary plan. Alternatives are ranked from 1 to 99 with higher values indicating 
a greater preference. 

• Coverage or CoPay Information Available Indicates that there is additional Formulary 
Coverage and/or copay information available for this medication. Click the icon appearing next to 
the medication in the grid to display coverage information for that drug.  

Selecting a Therapeutic Alternative Drug 
The following example is used to explain how to select a Therapeutic Alternative medication in place of a 
non-Formulary one.  

To select a therapeutic alternative drug: 
1. The provider is prescribing Zestril (Lisinopril) for this patient.  

 

Note:  If Zestril is non-formulary (the Non Formulary Medication Icon   displays in the Fm 
column). 
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2. The provider double-clicks the Non-Formulary Medication icon to view and select from a list of 
therapeutic alternatives for Zestril. This displays in the Formulary Status window. 

 
3. Therapeutic alternatives of the same drug class are displayed. Note that the Formulary Status 

for each alternative (Status column) is also listed.  

 
4. The provider reviews the list, selects (clicks) the drug Lisinopril 10 mg as an alternative, then 

clicks Prescribe.   

 
Lisinopril now appears in the Medication list. Note that this selection is In Formulary according to 
the icon in the Fm column. 

Setting Formulary Benefits Options 
Users have several options for setting up how Formulary Benefits functions behave in ScriptWriter.  

These options are found under the ScriptWriter tab of the e-MDs Chart Options window (File > 
Options...). 
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The available options are: 

• Auto-Check Formularies. 

• Display Alternatives for Off Formulary Drugs. 

• Display Coverage/Copay Information. 

Auto Check Formularies 
When this option is selected, a formulary status icon (Approved, Non Formulary Medication, Preferred, 
etc.) automatically displays in the Fm column with each medication.  

 

If this option is not selected, the Formulary Value Unknown icon  displays in the Fm column for each 
medication. To check if the medication is in formulary, the user must click the icon to display its formulary 
status. 

  

Display Alternatives for Non-Formulary Drugs 
When this option is selected and the user selected a non-formulary drug from the Choose Medication 
window,  
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the system automatically displays a message that it is retrieving therapeutic alternatives..: 

 
...and opens the Formulary Status window allowing the user to select an in formulary drug. 

If the Display Alternatives for Formulary Drugs option is not selected, the user must click a non-
formulary  or Non-reimbursable  icon to view alternatives. 

Display Coverage/Copay Information  
When the Coverage/Copay option is selected and the user has downloaded benefit information for that 
patient, the system acts as follows: 

When a user clicks on a drug (that includes a form strength) in the Medication List grid, the 
coverage/copay information displays automatically for several seconds in the upper right corner of the 
window.  

If the Coverage/Copay option is not selected, the Medication List window does not display 
coverage/copay information whenever a medication is clicked in the grid. To view this information, the 
user must either click the Coverage Copay tab after clicking the medication or click the Coverage/Copay 
icon   next to the medication to display the information.  

Considerations for Setting Formulary Options 
Formulary Benefits options were designed to allow the user to fully automate the formulary checking 
process or perform some or all checking and selection tasks only as needed.  

Setting for Full Automatic Checking 

 
For full automatic checking, select all the options. With this configuration, all medications (that have a 
form strength selected) will be checked for formulary status as they are entered. If a medication is non 
formulary, the system automatically opens the Formulary Status window allowing the user to select a 
therapeutic alternative. Also, Coverage/Copay information displays automatically on the Medication List 
whenever a drug on the grid is selected (clicked).  

Full automatic checking is convenient; however, it can slow the prescribing process by requiring the user 
to wait while the system retrieves information for each medication. 
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Setting for Partial Automatic Checking 

 
By selecting Auto Check Formularies option and not selecting Display Alternatives for Off Formulary 
Drugs, the system displays the Formulary Status icon for each drug on the Medication List window but 
the user must click any non-formulary or non-reimbursable icons to view and select a therapeutic 
alternative. 

Setting for Full Manual Checking 

 

If the user selects neither option, she or he must click the Formulary Value Unknown icon  in the Fm 
column of the Medication List to perform Formulary Checking. If the check returns the either the non-
formulary  or non-reimbursable  icon, the user must click that icon to display therapeutic 
alternatives.  
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3 
Medication History 

Another function available as part of the Formulary Benefits add-on is the ability to 
download a comprehensive list of all medications prescribed for a patient. This list 
includes medications prescribed by any physician and filled at any pharmacy provided 
the prescription was submitted to one of the Pharmacy Benefit Manager (PBM) 
organizations for payment.  

With this function, physicians can verify what another doctor has prescribed for a 
patient and help avoid possible duplicate prescribing. The list also helps clinicians 
identify medications prescribed by others that a patient may fail to mention as part of 
their medication history or for which they cannot provide adequate information (drug 
name, form strength, etc.). 

Continued on the next page ... 

e-MDs Solution Series Formulary Benefits User Guide 8.0 R00 18 



 

Maintaining Information Security 
Before accessing a patient’s medication history for the first time, a user must document in Solution Series 
that the patient (or guardian) has given permission for the clinic to download this information. Once 
permission is documented in the system, clinicians are not prompted again to document this information 
unless the patient has changed the level of permission granted or revoked it altogether. A change in 
permission level or status is performed from the patient’s demographic record. 

Downloading a Patient’s Medication History 
A patient's current and past medications can be viewed from Chart's Visit/HS view. 

To view a patient's medication history: 
1. In the patient's chart, click the Visit/HS tab to show the Health Summary. 

2. Click the plus sign (+) before the blue Current Medications label to expand the patient's 
medication list. 

3. Click the Med Rec button to open the Medication Reconciliation window. 

 
4. The Medication Reconciliation window opens, displaying the patient's current medications in the 

screen's left panel.  

5. Go to File > Import from Medication History to open the RxHub window.  If this is the first time 
the medication history has been accessed for this patient, the Consent Selection Form box 
opens. 

You can document Consent, Restricted Consent, or Consent denial here. Note that Restricted 
Consent will only display the medications prescribed by the current provider.  

6. Select the appropriate consent provided by the patient or guardian, then click the OK button. 
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The Medication History From RxHub window displays the patient’s medication list. Medications 
are listed by Last Fill Date with the most recent date appearing at the top.  

 
7. To close the window, click the OK button. 

Setting or Updating Patient Consent 
Medication History patient consent is stored in the patient demographic record under the Misc tab. All 
patients are initially set to the status CONSENT DENIED until it is changed in the demographic record or 
by completing the Consent Selection Form which displays the first time a user tries to access a patient’s 
medication history. 
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To alter the Medication History Consent status, access the patient’s demographic record and change the 
Medication History Consent field. 

 
The choices are: 

• Patient consents 

• Parent/Guardian consents 

• Restricted patient consent (displays current provider prescription history only) 

• Restricted parent/guardian consent (current provider only) 

• CONSENT DENIED 

Note:  If a patient or parent/guardian initially denies consent and this was documented using the Consent 
Selection Form window, the user must change the consent using the Medication Consent Field in the 
Patient Demographic record to change the status before accessing the medication history. 
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4 
Mail Order e-Prescribing 

Another feature of the Formulary Benefits functionality allows users to send 
prescriptions electronically to mail-order pharmacies if allowed by the patient’s 
formulary plan. This operation is similar to SureScripts e-prescribing to retail 
pharmacies.  

Continued on the next page ... 
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System Overview 
When prescribing for a patient whose pharmacy benefits information has been downloaded, the system 
checks whether mail order e-prescribing is allowed. If so, Mail Order pharmacies that have been entered 
into Solutions Series are made available for e-prescribing. If the patient’s coverage does not include this 
form of prescribing, or there is no benefit information available for the patient, e-prescribing to any listed 
Mail Order pharmacy is blocked.  

To e-prescribe to a mail-order pharmacy: 
1. Check that current Formulary Benefits data has been downloaded for this patient. Do this by 

looking at the RxHub Check icon on the Medication List window for patient. If the icon is active 

, click the icon to download current (i.e.: less than 24 hours old) benefits information. If the 
icon is inactive (“grayed” out ), current benefits data is already available.  

 
2. Select Electronic as the Send method for the medication. 

 
3. In the Pharmacy column, click the down arrow to display pharmacies. Note that if the patient’s 

benefits does not include Mail Order e-prescribing, the system will not allow selection of a Mail 
Order pharmacy from this drop-down list. 
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Searching for Electronically Enabled Mail Order 
Pharmacies 
The Find Pharmacy search window includes search options to display only Electronically Enabled Mail 
Order Pharmacies.  

To select an electronically enabled mail order pharmacy: 
1. Click the Search icon located in the Pharmacy column to display the Find Pharmacy window. 

 
2. Click only the check box Electronically Enabled Mail Order, then click the Search icon.  

 
3. Highlight the desired pharmacy and click the Select icon. 
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